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SOLUTIONS

RFID Troubleshooting Guide

Top Problems

e MEDIA OUT errors

e RIBBON OUT errors

e RFID Tags voiding excessively or 100% fail
e RFID data not encoded into chip

e Labels Skewing

e Print Image shifted too far Left/Right

e Printer settings change (USB & LAN I/F)
e SKIPPED/BLANK labels

e Print image wandering into label gaps
e LIGHT Print/POOR print quality

e RIBBON wrinkling

e Label Wrap Jam/Faulty Tear Off

- More Likely |Less Likely |:>
&
S ’5&0, "o % {% 2, %,

Top 12 Problems % Yon 3, & % % % o % o
MEDIA OUT errors L 1&3 .5
RIBBON OUT errors oo 1&3 =D
RFID Tags voiding excessively or 100% fail 1 2&1 . 4&6 5
RFID data not encoded into chip -7
Labels Skewing L3
Print Image shifted too far Left/Right .3
Printer settings change (USB & LAN 1/F) -7
SKIPPED/BLANK labels L 1&3 L5
Print image wandering into label gaps . 1&3
LIGHT Print/POOR print quality . 3&7&5 .. 4 5
RIBBON wrinkling .3
Label Wrap Jam/Faulty Tear Off .3

v v

... X Troubleshooting Steps below
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Tools available to End Users, Supervisors, Level 1 and Level 2 Support
Technicians

Printer Support Web page via QR Code that is printed on the printer media cover and can be displayed
for any error condition.

Smartphones and Mobile Computers via QR Code capture by camera or imager:

https://www.zebra.com/us/en/support-downloads/m/qr-code/zt400.html

Desktop PC’s

https://www.zebra.com/us/en/support-downloads/printers/passive-rfid/zt411.html

PRINTER STATUS

STATUS PAUSE DATA SUPPLIES NETWORK

Printer is ready.

Media supply is out.

Ribbon supply is out.

Ribbon not required in Direct Thermal mode.
Printhead is open.

Printhead is over temperature.
Printhead is under temperature.
Unable to read the dpi setting.
Network connected (100Base or WLAN).
Ethernet error found.

WLAN is Associating.

.~ WLAN is Authenticating.
WLAN signal is weak.

For Video Instructions:

Scan QR code or go to
www.zebra.com/ZT400-info

P/N: P1105756

Lowry Solutions — Trane Technologies
Page 2



)

{ 0\ IRY . .
SOLUTIONS RFID Troubleshooting Guide

Individual QR Codes by error type (firmware dependent)

RIBBON OUT

Flashing Red

oL

Ribbon Out i Ribbon Out

Ribbon is out
Replace the ribbon.
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MEDIA OUT

P L 3 ' ¢
Media Out 53 Media Out

Media is Out
Please Load Media

< >

Printer

_ ActiveIP (Wired)

1 Calibration — Symptoms of faulty calibrations:

=  RFID Tags voiding, Blank labels printing, False Media Out, False Ribbon Out, Print
Image wandering into label gaps, LABEL LENGTH value in configuration is too
short/long.

o Resolution

= Verify the Ribbon is loaded above the metal tab as shown below in the throat of
the printer on the left-hand side. If the ribbon is loaded below this metal tab,
the ALERT RIBBON OUT error message will never clear. The interior
device.light.head _open_brightness setting is off to get clearer picture of metal

tab.
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Ribbon MUST be threaded above
metal tab following the path of the
directional arrow to Clear RIBBON

= Verify the Media Sensor is in the correct position shown below.

__.:Ei;itr]]l}”tlﬂlii[l:

§ Building -
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SOLUTIONS RFID Troubleshooting Guide

= Clean sensors and label/ribbon path. See video titled Media Sensor & Exterior

Cleaning at Zebra website: https://www.zebra.com/us/en/support-

downloads/printers/passive-rfid/zt411.html

=  Perform Media Calibration:
https://supportcommunity.zebra.com/s/article/ZT411-ZT421-Ribbon-Media-
Sensor-Manual-Calibration?language=en_US

= Perform RFID Calibration:
https://supportcommunity.zebra.com/s/article/ZT411-ZT421-RFID-
Calibration?language=en_US

2 RFID Calibration — Symptoms of faulty RFID Calibrations
=  Excessive voiding > 5% -10% range or higher than normal or 100% Void rate
o Resolution
= Clean sensors and label/ribbon path. See video titled Media Sensor & Exterior

Cleaning at Zebra website: https://www.zebra.com/us/en/support-

downloads/printers/passive-rfid/zt411.html

= Media Calibration: https://supportcommunity.zebra.com/s/article/ZT411-
2T421-Ribbon-Media-Sensor-Manual-Calibration?language=en_US

= RFID Calibration: https://supportcommunity.zebra.com/s/article/ZT411-
ZT421-RFID-Calibration?language=en US

= Inspect/compare RFID tags against known working tags in the environment and
ensure the inlays look to be present, are similar in size and shape, placed in the
same orientation and in the same relative position as the problem printers RFID
tags. Label material should have the same part numbers affixed to them.

= Perform an RFID Calibrate from the RFID submenu on the printer LCD menu.
This will take ~ 6:15 for 4 X 6 labels.

= RFID Calibrations should yield a range of values as show in the table below for

the Lowry label material:
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This parameter selects an antenna element from the printer’s antenna array.
Values:

E1,E2,E3, E4

D1, D2, D3, D4

C1,C2,C3,C4

B1, B2, B3, B4

Al, A2, A3, A4

=
=
E
5
€
—

o

platen roller /

= These values are available within the RFID Submenu on the printer LCD.

PROG POS. | ANTENNA READ PWR | WRITE PWR
F2 A4 20 20
F2 A4 19 19
F2 A4 19 19
F2 A4 21 21
F2 A4 20 21

3 Mechanical Printer Setup — Symptoms of Mechanical printer setup problems

= Light or Dark Print Quality, Ribbon wrinkling, splotches in print, Labels skewing

or crunching in the label path during printing. False Ribbon Out errors.

o Resolution

= Verify adjustable Media Guides are adjusted correctly — not too tight and not

too loose.
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= Verify pressure dials are set correctly. Even pressure is recommended starting
point, but one dial or the other may require more or less pressure on the
printhead. This adjustment is best done by pressing the feed key repeatedly and
observing how the labels track through the machine. Labels should not be
crunching up against the outer media guide. A good starting point is to have 3
tic marks on the yellow dial gauges facing front of printer on both dials. Lesser

values will cause label slippage and wandering print image.
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Partio 30500260  RFID

L ——
O 120 Order Mo 730547001

Light print or Dark print can be adjusted by checking and adjusting the Darkness
settings. Average Darkness value will be in the +13.0 range. The Darkness
setting can be impacted by the Host settings as well so always cycle printer

power before changing Darkness value.

Ribbon wrinkling is usually caused by:
1) Adjustable media guides are too loose allowing the label and ribbon to move
back and forth as labels are printing.
2) Darkness setting is too high.
3) Pressure dials are set unevenly.
4) Platen drive roller is worn or needs cleaning.
)

5) Ribbon supply spindle tension is not correct.
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4 RF Environment — Symptoms of RF Interference

=  Printer RFID encoding performance is good when physically positioned in certain
areas of a plant and then very bad in other areas. This takes some run time to
determine.

o Resolution

=  Media Door on all RFID printers should be closed at all times unless changing
out media. This will minimize any RF energy interfering with encoding the RFID
tags.

=  Pay close attention to any sources of RF energy in immediate vicinity of the
printer that emit RF energy. Isolating the source is by process of elimination.
Relocate the printer and see if the Void rate decreases. That tells us it’s

environment that’s causing the problem.

5 Media & Ribbon Quality — Symptoms of media and ribbon quality issues

= Drastic change in Void rate and print quality when new roll of labels is loaded
into the printer usually point to a change in the label top coating. Label thermal
transfer topcoats have varying static properties which can cause RFID chips to
fail excessively if the wrong one is applied. Test these labels on a known good
working printer to see if the problem duplicates. If it does duplicate, there may
be an issue with the lot of labels. If the problems do not move to known working
printer, the issues may be in the printer mechanical setup or Darkness settings.

= Same principle above applies for ribbons. Zebra’s use Coated Side Out Ink
ribbons which means the ink is facing down and the ribbon unwinds in a
clockwise direction off the supply spindle. Ribbon inks have static properties as
well and can be the cause of premature chip failures.
The ribbon and label are a matched set. Always be wary when substituting
ribbons. Sometimes Coated Side In Ink ribbons are installed by mistake which
means the ink ink is facing up as it goes through the printer and the result is that

the ink is burned to the printhead and nothing is printed.
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The printhead usually burns through the printhead at this point as well and fouls
the print head up with ink that must be cleaned off. A simple test is to use a
piece of label or scotch tape and apply to the bottom face of the ribbon that
touches the label and then peel it off. Ink should come off and stick to the
adhesive if the correct Coated Side Out Ink ribbon is installed.

= Abnormal buildup of label adhesive in the printer label path signals that the
converting facility applied too thick a coat of adhesive onto the label backing
and should be reported.

= Labels fall off the backing prematurely OR the labels do not stick to the product
they are applied to. This means the adhesive coating is too light — not enough

has been applied.

6 Media Storage — Symptoms of Media Storage problems

= Label material is warped or puckered, Print Quality is splotchy at random and

Printer may jam more frequently.
o Resolution

=  Store RFID labels at proper temperatures—RFID labels should be stored at
temperatures of approximately 72 degrees Fahrenheit (22 degrees Celsius) at
50% Humidity in environmentally stable conditions. Exposure to electro-static
discharge (ESD), which can affect tag performance, should be limited. Low-
humidity environments may require the use of anti-static mats or clothing to

help counter ESD.
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7 Host Setup — Symptoms of Host Setup problems (in most likely order)

Supplier PC Side: eBots Registry Change has not been accomplished. See

https://lowrysolutions.com/trane-comply/ Step 5 to download document on

how to accomplish that.
Supplier Side: eBots version is incorrect. Must be at V7.7.0. See Step 6 of

https://lowrysolutions.com/trane-comply/ which downloads the eBots

Installation Guide and refer to Page 3 to download the latest eBots Application.
Printer loses communication with USB or Networked printer during long periods
of idle time requiring the printer power to be cycled to re-establish
communication.

Host generating spool files may not be sending RFID encoding commands to the
printer. Perform the ZT411R Encoding Check PDF that is located on the Trane
compliance website Step 12 to confirm the EPC Data matches

https://lowrysolutions.com/trane-comply/

Page Sizing errors are being generated at print time.

Printer settings are changing at random and for unknown reasons causing light
or dark print, changing print speeds and false Media or Ribbon Outs. Very
common with USB connected printers.

Plant Side label format is not set to “Vendor RFID Portrait”. See Steps 7 thru 9

on the Trane compliance website https://lowrysolutions.com/trane-comply/
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o Resolution for Page Sizing error or Printer settings are changing at random on USB (or

LAN) connections

Services is at V7.7.0.0:

e) eBizBots Laser Jet Printer Services

Fle View Tools Help Sl

=B B &

About Printer Services

eBizBots Printer Services
Copyright € 2000-10 eBots, Inc

Thiz product iz licensed to :

Mame: Lowry Solutions
Company: Lowvry Solutions

Additional lnfarmation:

eBzPrintS v - eBizBots Printer Ser
ersion: 7.7.0.0

‘Wiarning: this computer program is protected b,
treaties.

Unauthorized reproduction or distribution of thi:
rezult in zevere civil and criminal penalties, anc
extent possible under the law.

b

Must be
V7.7.0.0 or
higher.
Older
versions
will not
work

pressing OK:

File View Tools Help
=)

Click on File>Configure Service...

Printer Services Configuration

I™ Using a Proxy Server HTTP Test...

Printer Options
" Select printer from printer
& Use Default Printer

9
Left Margin in Units of 1/1000 inch: 0
0

Top Margin in Units of 1/1000 inch:

I™ Print Copies Together

Label Options:
# of Rows Per Page:

1
# of Columns Per Row: 1
Vertical Gap in units of 1/1000 inch: 0

0

Horizontal Gap in units of 1/1000 inch:

Others

No.of Days of Log Files to Keep: 5

:

Server Settings
‘WebServer URL:
[13 Cancel

I Show Confirmation Dialog Trace Level |None -

"Use Default
Printer" is not

rintetrae. || | thE SAME AS

Windows
"Default”
printer. This
setting is for
eBots only
and must be
set for
automatic
printing.

Open eBots Printer Services and confirm installed version of eBots Printer

Confirm Configure Service settings are correctly configured as shown below and
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= C(Click on File>Printer Setup and confirm the screen is as shown below and

press OK:

Print Setup ? X
~ Printer \
Mame: ZDesigner ZT411R-300dpi ZPL Properties. .. |

Status: Ready

Type: ZDesigner ZT411R-300dpi ZPL DefaUIt for

Where:  LAN_192.168.1.14_1
C"mme"‘:/ eBots only

[V Set this printer as my default printer |

— Paper Crrientation

% Portrait

Size: |46 PINK RFID V1 =] X
LI " Landscape

Source: II'U'IanuaI feed

Metwork... | QK I Cancel

= NOTE: Version 5 or Version 8 ZDesigner Drivers may be installed. Version
5 ZDesigner Driver is shown below. Version 8 ZDesigner Driver settings

differ and follow V5 screenshots.

Lowry Solutions — Trane Technologies
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V5 Driver: Confirm the printer driver Printer Properties>Advanced> Printing

Defaults> Stocks is set for 4X6 PINK RFID V1 for the 4 X 6 RFID Label Form and
select “Use printer settings” for printer under the Advanced Setup tab. If 4X6
PINK RFID V1 Stocks is not listed below proceed to Trane Compliance website

https://lowrysolutions.com/trane-comply/ Step 4a or 4b and download the zip

file link contained within the USB or LAN Driver Setup document. Within the zip

file, the Driver Setup file will be contained with instructions on how to import it.

@Q ZDesigner ZT411R-300dpi ZPL Properties l;é.] ZDesigner ZTA11R-300dpi ZPL Printing Defaults >
Printer Settings ~ Stocks Language &e Barcode Forts Command Fonts
General Sharing Ports Advanced Custom Commands Import/Export settings Tools About
Options Advanced Setup Dithering Stocks Printer Memory
(®) Always available
e T ings
() Awvailable from 12:00 AM o

Mo. Of Copies:
Priority: 1 : Speed: 6 e

_ | Darkness 10
Drver Sl C TR T Stocks: 4XGPINKRFIDVI v
] o Paper Format
(®) Spool print docurents so program finishes g it @ portrait .
Start printing after last page is spooled (_landscape
(O Start printing pageis sp mm p
(®) Start printing immediately ®inch [rotate 180°
\:) Print directly to the printer o
Width: 409
old mismatched documents 6.00
int spooled documents first
printed docurments 0.00 Top: 0.00
Enatle advanced printing features 0.00 Battom 0.00

Printing Defaults... Print Processor..

oK || Cancel

. Cancel | | feply | | Hebp
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8 ZDesigner ZT411R-300dpi ZPL Printing Defaults gy X
Barcode Forts Command Fonts
Custom Commands Import/Export settings Tools About
Options ~ Advanced Setup Dithering ~ Stocks Printer Memory
Use printer settings \
Operation Mode —k
Tear off Applicator
Rewind Stream
Peel Off RFID
Lineress Peel Cutter
Lineress Cut Group Quartity: 0

Lineress Delay Cut Advanced ™
Mimror Image Inverse

Media Type
Themal Transfer Thermal Direct

Tracking Mode

Continuous Mark Sensing

Web Sensing

Adjustment
Top 0.00 inch
Tear Off 0.00 inch
Left Position 000 inch

Other Settings ? *
Use printer settings —
Backfeed
Mo backfeed Before printing
Default settings After printing
Pause
(® No Pause () Ater Job
() After Label () After Interval 0
Labeling Software Settings
[] Safe graphics printing
Graphic Settings
Use ZIP compression
Commands
[] Enable Passthrough Maode Start sequence: 5
End sequence: i3
[]Cancel before print
[] Time now mode for RTC
Control characters substitution
Format & control prefixes and delimiter: Sftaﬂdard V_.
Rfid Setup : :
Use printer tag type sstting h ,
[Help |

= V5 Driver: Configure the printer driver Printer Properties>Printer Settings>Override

Applications Default Settings and check “Use drivers settings” for printer under the

Printer Settings tab. This prevents the application from making changes to the

datastream going to the printer.
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E-E] ZDesigner ZTA11R-300dpi ZPL Properties @—v

General Sharing Ports Advanced Color Management
Printer Settings  Stocks  Language  Barcode Forts  Command Fonts

|se these selirgn
detailed explanation
changes to take effect.

caution - please read driver documentation for a
wsome applications must be restarted for the

Frirter Fonts
{®) Printer default () Vector fonts
() Raster forts Merged characters
Thiz setting determines how the printer fonts are presented to the
applications.
Spool Format
(®) Printer defautt () Enhanced metafile
(") Raw

A spool format of the print job is defined here.
Line Substitution

(®) Printer defautt () Disabled

(") Enabled

Should the driver try to replace lines and rectangles in the drawing
with intemal elements?

Command Separation

Printer default MNumber of zeros:

Cvemide Application Default Settings -
Always use drivers settings

Security
About

Help

V5 Driver: Duplicate this process above by right clicking on Printer Preferences this
time to ensure the driver settings match up between Preferences and Properties.
“Preferences” values are tied to the local Windows User that is currently logged on.

“Properties” values are related to settings on a shared network printer.

V8 Driver: Confirm the printer driver Printer Properties>Advanced> Printing
Defaults> Page Setup> Stock Select is set for 4X6 PINK RFID V1 for the 4 X 6
RFID Label Form. If 4X6 PINK RFID V1 Stocks is not listed below, proceed to

Trane Compliance website https://lowrysolutions.com/trane-comply/ Step

4a or 4b and download the zip file link contained within the USB or LAN
Driver Setup document. Within the zip file, the Driver Setup file will be

contained with instructions on how to import it.
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#h ZDesigner ZT411R-300dpi ZPL V2 Properties i e

General Sharng Ports  Advanced  Color Management Securty Driver Settings

(®) Always available

O Available from m To 12:00 AM o

Driver: |ZD5ignerZT4'I'IR-3[N]dpiZPL V|| MNew Driver... |

(®) Spool print documents so program finishes printing faster
() Start printing after last page is spooled
(®) Start printing imrmediately

() Print directly to the printer

[JHold mismatched documents

Print spooled docurnents first

[]Keep printed docurnents

Enable advanced pri eatures

| Printing Defaults... | | Print Processor... | | Separator Page...

@ ZDesigner ZT411R-300dpi ZPL V8 Printing Defaults bt

Printer Settings P

[ PageSetup Stock
Print preview

= Print Options Select: 4¥6 PINK RFID W1 v|
Media settings .
P Operation Mode
. [ Em T—T=F
@ Graphic Options Height: o S
Custom Commands Media type: N/A v | [
#% Maintenance Mark offset: W @ VAW
k. Units Mimor label [
R
Jinverse
i Help and About

Lowry Solutions — Trane Technologies
Page 18



SOLUTIONS RFID Troubleshooting Guide

= V8 Driver: Confirm the printer driver Printer Properties>General> Printing

Preferences> Page Setup> Stock Select is set the same way as shown below:

@ ZDesigner ZT411R-300dpi ZPL Y& Properties h

é; ZDesigner ZT411R-300dpi ZPL V8 Printing Preferences h

Printer Settings

[ PageSetup Stock
) Print preview

¥ Print Options Select: 4X6 F"|Nk RFID W1 |
fiedia settings -
¥ Operation Mode
Width: 4 ‘@ 1;'
@ Graphic Options Height: g @
E® Custom Commands Media type: N/A ]
Rotation: 0° - Portrait v m
5% Maintenance — wh - e e
E. Units Miror label  [§
[ e o e
[inverse
i Help and About

o Resolution for Communication problems.
= USB Printers: Disable USB selective suspend settings in Control Panel\All Control
Panel Items\Power Options\Edit Plan Settings
® |n Device Manager — ALL USB Root Hubs > Properties > Power Management,
setting for “Allow the computer to turn off this device to save power” should be

unchecked.
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'
\J - -
H ’ Edit Plan Settings

% Power Options ?

Advanced settings

- Select the power plan that you want to customize,
\Q and then choose settings that reflect how you want
your computer to manage power.

:Balanced [Active] v

X

On battery: 10 Minutes
Plugged in: 80 Minutes
Internet Explorer
Desktop background settings
Wireless Adapter Settings
Sleep
2
(=] USB selective suspend setting
On battery: Disabled

Plugged in: Disabled

[= Turn off hard disk after A

&
a
)
o
1=l
o
=
Q
[}
o
=
@

v e Universal Serial Bus controllers
Generic USB Hub

Sentinel HASP Key
Sentinel HL Key

Sentinel USB Key

USB Composite Device
USB Composite Device
USB Composite Device
USB Composite Device
USB Mass Storage Device
USB Root Hub (USB 3.0)
USB Serial Converter

0 = =@ =@ @ =G =@ =G G =G = -

4N ‘) > Control Panel > All Control Panel ltems > Power Options > Edit Plan Settings

Change setting

Choose the sleep ar

k. Turn off the dis
Q Put the comput

< Adjust plan bri

»

Change advanced p

Restore default sett

Intel(R) USB 3.0 eXtensible Host Controller - 1.0 (Microsoft)

-+
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! Paristss Deiices USB Root Hub (USB 3.0) Properties X
W Ports (COM & LPT)
+ = Print queues General Driver Details Events PowerManagement h
- ™ Printers
) D Processors *, USB Root Hub (USB 30)

B9 Security devices

l‘ Software components

B Software devices

i‘ Sound, video and game controllé¢
- S Storage controllers
- @ System devices
v i Universal Serial Bus controllers
Generic USB Hub
Intel(R) USB 3.0 eXtensible Ha
Sentinel HASP Key
Sentinel HL Key
Sentinel USB Key
USB Composite Device

@ the computer to turn off this device to save power
SHOw this device to wake the computer

-

USB Composite Device
USB Composite Device
USB Mass Storage Device
USB Root Hub (USB 3.0)

*

USB Serial Converter 0K Cancel

J
)
)
J
Y
i USB Composite Device
v
J
J
J
)
W

. ™ WSD Print Provider

Lowry Solutions — Trane Technologies
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‘*N,

o Resolution for Network IP Communication problems

= On printers web page, go to Network Configuration>TCP/IP settings and set IP
Protocol = PERMANENT and set the ARP Broadcast Interval to 3 minutes. Then
click Submit and then click on View and Modify Printer Settings, scroll to bottom
and select Save Current Configuration and then repeat and select Reset
Network for changes to take effect.

» TCP/IP Settings

Setting Internal Wired
IP ADDRESS 192.168.001.044
IP PROTOCOL PERMANENT v
SUBNET MASK 255.255.255.000
DEFAULT GATEWAY 192.168.001.001
WINS SERVER IP 000.000.000.000
TIMEOUT CHECKING YES ~
TIMEOUT VALUE 300
ARP INTERVAL 3
BASE RAW PORT 6101 B
CLIENT ID ENABLED OFF
CLIENT ID TYPE MAC ADDRESS -
CLIENT ID PREFIX
CLIENT ID SUFFIX00074DA33BD9

Submit Changes «

Lowry Solutions — Trane Technologies
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View and Modify Printer Settings

General Setup \

Serial Communications Setup
Network Configuration
RFID Setup
Print Listings on Label
Media Setup
Calibration
Z.P1. Control
Advanced Setup

Save Current Configuration s
Restore Saved Configuration
Restore Default Configuration
Restore Default Network Configuration

Reset Network ——

Author: Dave Dooling
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